
 

World HQ 
Neocom Software 
8th Line 29, Vasilyevsky Island 
St. Petersburg, 199004, Russia 

US Office 
Neocom Software 
15200 Jog Road, Suite 202 
Delray Beach, FL 33446, USA 

Internet 
 
Email: info@trbonet.com 
WWW.TRBONET.COM 

Telephone 
EMEA: +44 203 608 0598  
Americas: +1 872 222 8726 
APAC: +61 28 6078325 

  

 

TRBOnet Swift CPS 
User Guide 

Version 1.8 



 
 

Notices 
This document is for informational purposes only. Neocom software, Ltd offers no 
warranties, express or implied, in this document. 
Neocom and the Neocom logo, TRBOnet and the TRBOnet logo are either registered 
trademarks or trademarks of Neocom software, Ltd. 
MOTOROLA, MOTO, MOTOROLA SOLUTIONS and the Stylized M logo are trademarks 
or registered trademarks of Motorola Trademark Holdings, LLC. 
Microsoft, Windows, SQL Server and the .NET logo are either registered trademarks 
or trademarks of Microsoft Corporation in the United States and/or other jurisdictions. 
Other product or company names mentioned herein may be trademarks of their 
respective owners. 
 
© 2019 by Neocom Software, Ltd. All rights reserved. 
 
Last revised on January 28, 2019. 
 



 
 

ii TRBOnet Swift CPS 1.8 – User Guide 
 

Contents 
1 Introduction ........................................................................................................................................................ 1 

1.1 About This Guide ................................................................................................................................ 1 

1.2 About TRBOnet Swift ......................................................................................................................... 1 

1.3 Contacts .................................................................................................................................................. 1 

2 Overview .............................................................................................................................................................. 2 

2.1 About TRBOnet Swift CPS ............................................................................................................... 2 

2.2 About Swift Event Logic ................................................................................................................... 3 

2.3 Software Requirements .................................................................................................................... 3 

2.4 Licensed Features ............................................................................................................................... 3 

3 Installation and Upgrade ............................................................................................................................... 4 

4 Device Programming ....................................................................................................................................... 5 

4.1 Swift CPS Options ............................................................................................................................... 5 

4.2 Device Connection ............................................................................................................................. 6 

4.3 Firmware Update ................................................................................................................................. 7 

4.4 Device Configuration ......................................................................................................................... 8 

4.4.1 Configuration Files .................................................................................................................... 8 

4.4.2 Connection Settings .............................................................................................................. 10 

4.4.3 Swift Event Logic ..................................................................................................................... 12 

5 Activation of Features .................................................................................................................................. 31 

 



Introduction 

1 
 

1 Introduction 
1.1 About This Guide 

This document is intended for engineers responsible for building MOTOTRBO radio 
networks and programming two-way radios for end users. 

1.2 About TRBOnet Swift 
TRBOnet Swift is a family of hardware products by Neocom Software, Ltd designed 
for use in MOTOTRBO radio networks. The TRBOnet Swift family hardware is 
presented by RoIP gateways A100 and A200, option board ST002. 

1.3 Contacts 

Region Phone Email & Support 

EMEA +44 203 608 0598 
info@trbonet.com — general and 
commercial inquiries 

support@trbonet.com — technical support 

http://kb.trbonet.com — online knowledge 
base  

Americas +1 872 222 8726 

APAC +61 28 607 8325 

 

mailto:info@trbonet.com
mailto:support@trbonet.com
http://kb.trbonet.com/
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2 Overview 
2.1 About TRBOnet Swift CPS 

TRBOnet Swift CPS is a configuration editor designed for programming MOTOTRBO 
GOB option boards and the TRBOnet Swift family electronic devices with Swift Event 
Logic on board. 
TRBOnet Swift CPS can work with configuration files and with configurations loaded 
from devices. In addition, it can update the device firmware, read device memory, and 
program devices with an extended configuration provided by Neocom Software, Ltd 
by customer request. 
The intuitive user interface serves to facilitate every step of device programming. 

• Automatic detection of a connected device 

TRBOnet Swift CPS can connect devices using the USB, LAN, or OTAP interface. 
Devices connected to USB are detected automatically. The number of 
connected devices is only limited by the number of USB ports available on the 
computer. 

• Device-specific settings only 

TRBOnet Swift CPS displays the configuration settings specific to a given type 
of device. Where possible, the recommended settings are set by default.  

• Event Logic defined by rules 

Rule Editor facilitates the process of building Event Logic rules from 
configurable components. This tool allows the user to create new rules from 
copies with minimum effort. 

• Sample configuration files 

TRBOnet Swift CPS comes with a set of sample configuration files for all 
supported devices. Sample configurations include the default device-specific 
settings and demonstrate the use of rules for setting up various Event Logic 
features. Sample files can serve as a starting point for creating device 
configurations when other configuration sources are not available. 
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2.2 About Swift Event Logic 
TRBOnet Swift Event Logic is a unified programmable environment supported by 
TRBOnet Swift DT500, TRBOnet Swift ST002, and MOTOTRBO GOB. The basic 
configurable components of Swift Event Logic include events, conditions, and actions. 
Swift Event Logic extends the capabilities of a standard radio network by 
implementing special features such as Lone Worker, Man Down, No Movement, Crash 
Detect, Speed Limit, Telemetry, GeoRoaming, and GeoFencing. 

2.3 Software Requirements 
Category Requirements 

CPU Intel Core i3 

Memory 4 GB 

Display 1280x1024 minimal resolution, 1600x900 recommended resolution 

Additional Devices Speakers 

Supported OS Windows 7, Windows 8, Windows 10 

Software .NET Framework 4.6.1 

2.4 Licensed Features 
TRBOnet Swift Event Logic features are available on terms of commercial licensing. 
The following table describes the licenses that you need to purchase and activate on 
your device to use particular features. 

Note: If a configuration uses commercial features, they do not work until the 
required license is purchased and activated on that device. 

License Description Related features 

Location This license enables getting GNSS data 
from the radio. 

Sending GNSS reports to TRBOnet 
Server, Speed Limit, GeoRoaming, 
Geofencing 

Safety This license enables getting data from 
the accelerometer. 

Man Down, No Movement, Crash 
Detect 

DataPort This license enables data transfer on 
the RS-232 port. 

Communication with external devices 
over the RS-232 interface 

Voice Recording This license enables downloading 
voice call records and playing them 
back. 

 

 
The Lone Worker feature is enabled on a device when any of the above licenses is 
activated. 
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3 Installation and Upgrade 
The following table describes how to install, uninstall, upgrade, and load new firmware 
to your TRBOnet Swift CPS software. 

Notes: The distribution package for TRBOnet Swift CPS is available for download at 
www.trbonet.com. From the main page, go to Downloads and click 
Firmware. Click to download the latest version of Swift Utilities Pack. 
Before installing TRBOnet Swift CPS make sure that your computer meets the 
minimum software requirements. For more information, refer to section 2.3, 
Software Requirements (page 3). 

To install TRBOnet Swift CPS: 

• Double-click the TRBOnet Swift distribution file to run the TRBOnet Swift CPS 
setup wizard. Click Next. 

• Accept the terms of the license agreement. Click Next. 
• Click Install, then click Finish to exit the setup wizard. 

To uninstall TRBOnet Swift CPS from your computer: 

• Double-click the TRBOnet Swift distribution file to run the TRBOnet Swift CPS 
setup wizard. Click Next. 

• Select the Remove option. 
• Click Remove, then click Finish to exit the setup wizard. 

To upgrade TRBOnet Swift CPS to a newer version: 

• Install the new version on your computer as described above. 
Uninstalling the previous version of the product is not required. 

To load new firmware to TRBOnet Swift CPS: 

Note: The firmware for all supported devices is integrated in TRBOnet Swift CPS. 
When new firmware is issued, you can load it to TRBOnet Swift CPS without 
upgrading the software to the next version. 

• To load firmware to TRBOnet Swift CPS, open the SWU file. The firmware is 
unpacked and installed automatically. 

 

http://www.trbonet.com/
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4 Device Programming 
This section describes how to connect your hardware to a computer for programming, 
how to update firmware, and how to create or update a configuration on a connected 
device. 

4.1 Swift CPS Options 
• On the toolbar, click Tools > Options. 
• In the left pane, select Options > General. 

 

In the right pane, specify the following Swift CPS-related options: 
 Enable changing device mode 

Setting this option to ON will allow you to select the device mode when 
updating firmware on the device (see section 4.3,Firmware Update, step 
5). 

 Language 
From the list, select the interface language. 

 Show information drawings 
If you set this option to ON, useful information drawings will be shown at 
the bottom of the right pane when configuring device's Audio Settings 
and I/O Settings. 

 Show beta features 
If this option is set to ON, all beta features will be shown in Logic section. 

Note: This option is intended for advanced users only. 

 TRBOnet audio player path 
This is the full path to the TRBOnet audio player. If required, click the 
ellipsis button (…) and specify a different path for the audio player. 
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4.2 Device Connection 
TRBOnet Swift CPS can communicate with supported hardware over USB, LAN, or 
OTAP. To use a particular interface, launch TRBOnet Swift CPS, expand the 
Connection menu and choose the required option. 

 

The selected connection appears on the status bar, for example, "Connection: LAN". 

USB connection 
A USB connection is recommended for programming any supported hardware. This 
connection does not require any settings. Just connect the programming cable to the 
device and to a USB port of your computer, then launch TRBOnet Swift CPS and work 
with the device. Use the programming cable supplied with your device or 
recommended for use by the manufacturer of the device. 

LAN connection 
A LAN connection can be used for programming any hardware that can be connected 
to an IP network. Your device must be powered and connected to the same LAN where 
TRBOnet Swift CPS is installed. A brand new device has the following default IP 
settings: 

• IP address: 192.168.0.[xxx] 
• Subnet mask: 255.255.255.0 
• Default gateway: 192.168.0.1 

You may need to adjust the IP settings of your computer accordingly. 

OTAP connection 
An OTAP connection is used for over-the-air programming of endpoint devices such 
as DT500 connected to a MOTOTRBO radio or an option board ST002 installed into a 
MOTOTRBO radio. 
When you select OTAP on the Connection menu, the Options page appears. 
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Click Connections in the left panel. Specify the following OTAP connection settings: 

Setting Description 

Type of Switch The gateway that can establish an IP connection with TRBOnet Swift CPS and 
that can communicate with the device over the air. Values: 

• TRBOnet Server 
• Swift IP Gate: Swift A100, Swift A200 

IP Address The IP address of the gateway selected above. 

Port The Forward Data service port of the TRBOnet Server (if selected above). 
Default: 4011 

To get the port number, launch the TRBOnet Enterprise (PLUS) Server 
application and select Radio Networks, Digital Systems and Services in the 
left pane. Find the port number under the Forward Data service option. 

Note: Make sure that the Forward Data service option is selected. 

4.3 Firmware Update 
Before you proceed to device programming, we recommend that you update the 
device firmware to the latest version using TRBOnet Swift CPS. 
If your device is already configured, the configuration will be cleared from the device 
memory after you update the firmware. To preserve the current configuration, save it 
to a file and reload it to the device after the firmware update. 

To update the firmware version: 

 Launch TRBOnet Swift CPS on your computer. 
 Connect your device to the computer and point the connection type in the 

TRBOnet Swift CPS settings. For details, refer to section 4.2, Device Connection 
(page 5). 

 On the Device menu, click Update Firmware. 
 In the Firmware update window, select your device connected through USB. 

Or, enter the IP address of your device connected through the LAN and click 
Connect. 
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Note: If TRBOnet Swift CPS cannot detect a USB device, the cause may be the 
hardware driver not found on your computer. For details, refer to the user 
manual provided for your device. 

 Open the Mode menu and click the preferred mode. 

Note: If the Mode menu is read-only, close the Firmware update window. Then 
open the Tools menu and click Options. Make sure that the Enable 
changing device mode option is set to ON. 

 In the Firmware update window, open the Update to menu and click the 
firmware version to which the device will be updated. You can select the latest 
version or roll back to an earlier version if required. 

 Click Update to start the firmware update. The progress bar shows the progress 
of the operation. When the firmware update is completed, click OK to close the 
displayed message. 

4.4 Device Configuration 
This section describes how to configure Swift Event Logic and connections with 
external hardware, how to work with configuration files, and how to perform read and 
write operations on a device. 

4.4.1 Configuration Files 
This section describes operations with a configuration file in TRBOnet Swift CPS. 

 Opening a Configuration File 
In TRBOnet Swift CPS, you cannot create a configuration file from scratch. Instead, you 
need to open an existing configuration file, make the required changes, and save the 
result to a file or load it to a connected device. 
You can open a configuration from a file, for instance, from a sample file installed with 
TRBOnet Swift CPS. Or, you can read a configuration file from a connected device. 

To read a configuration from the device: 
• Connect a configured device to a computer. Select the connection type. 
• On the Device menu, click Read, or click the Read button on the toolbar. 
• (Optional) Specify the connection settings and click Read. 
• (Optional) If more than one connected device is detected, click the required 

device in the dialog box. Then click OK. 
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To open an existing configuration file: 
• On the File menu, click Open. Go to the required folder and click the 

configuration file. Then click Open. 
• Double-click the SWR file in the folder. 
• Drag the SWR file and drop it within the TRBOnet Swift CPS window. 

To open a sample configuration file: 
• On the Help menu, click Samples. 
• In the folder, click the sample file intended for your type of device. Click Open. 

TRBOnet Swift CPS displays each opened configuration on a separate page. The label 
of the page displays the name of the opened file or the device and the used 
connection. 
If you open multiple configurations, they appear each on a separate page. You can 
work with them in parallel. 

 Updating a Configuration File 
An opened configuration appears on a separate page in the main window of TRBOnet 
Swift CPS. The left panel of the page displays the logical sections of the configuration. 
If you click a particular section, the right panel shows the related configuration 
settings. 
The Device section includes the general information such as the type of device 
(model), the firmware version, the last date when the configuration was updated on 
the device, and the statuses of all features that require a license. To learn how to apply 
a license, refer to section 5, Activation of Features (page 31). 

 

Note: When you open a configuration file, the device information and the license 
information apply to the device whose configuration has been saved to the 
file. 
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If a device has external interfaces (RS-232, GPS, GPRS, other), the Device section 
includes additional sub-sections to configure communication through each external 
interface. To learn how to configure external connections of a device, refer to section 
4.4.2, Connection Settings (page 10). 
The Logic section includes the Swift Event Logic configuration settings such as rules, 
report profiles, network profiles, and other. If a device does not support Swift Event 
Logic, the Logic section is hidden. To learn how to configure Swift Event Logic settings, 
refer to section 4.4.3, Swift Event Logic (page 12). 

 Saving a Configuration File 
You can save an opened configuration to a file or load it to the memory of a connected 
device. If you just close the configuration page or the application window, you cancel 
all the changes without a prompt. 

To write a configuration to a connected device: 
• On the Device menu, click Write, or click the Write button on the toolbar. 
• (Optional) Specify the connection settings and click Write. 
• (Optional) If multiple connected devices are detected, point the required 

device in the dialog box. Click OK. 
• (Optional) If you write the configuration initially created for a different type of 

device, confirm the operation. 

Note: A configuration written to a different type of device includes all definitions 
from the Logic section of the left panel. Connection settings in the Device 
section are not written to a different type of device. 

To save a configuration to a file: 
• On the File menu, click Save As. 
• Go to the required folder. Click an existing SWR file to be updated, or type the 

name of a new configuration file to be created. Click Save. 

4.4.2 Connection Settings 
This section describes how to configure connections between your device and external 
hardware. To configure connections, open a configuration in TRBOnet Swift CPS as 
described in section 4.4.1.1, Opening a Configuration (page 8). The Device section in 
the left pane includes all connection settings available for the given device.  

 Audio Settings 
A configuration includes the Audio Settings section if you configure TRBOnet Swift 
A200 that is connected with the radio through the audio cable. Adjust the volume of 
the transmitted audio signal by changing the following settings. 

Setting Description 

Level of the input audio 
signal 

The level of the input audio signal in the range of -42Db to 20 Db. 

Level of the output audio 
signal 

The level of the output audio signal in the range of -42Db to 20 Db. 
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Setting Description 

Level of amplification of 
the input audio signal 

The amplifier of the input audio signal. 

Input for Audio The divider of the input audio signal. Values: 

 IN1: The divider is disabled (default). 
 IN2: Switch to this setting to the switch to lower the level of the 

input signal from the connected non-MOTOTRBO radio. 

 

 I/O Settings 
When you configure TRBOnet Swift A200, a device configuration includes the I/O 
Settings section. 

 

In the right panel, the physical I/O connector pins of Swift A200 appear as labels Pin 1 
through Pin 8. For each connected physical pin, specify the settings as described in 
the following table. 

Setting Description 

Pin function The function of the I/O pin. The value depends on the connected 
hardware: 

 If the pin is connected to external hardware, select the matching 
logical pin in TRBOnet software. Values: Input [1 : 10], Output 
[1: 10] 

 If the pin is connected to a radio connector pin through the 
service cable, specify the pin function. Values: Input Radio 
State, Output Radio State, Input CSQ, Output PTT. 

 If the pin is not connected, select Unassigned. 

Active level The active level of the physical pin. Values: Active Level High, 
Active Level Low. 

Pullup The pull-up. Values: Pullup Off , Pullup +5 V. 

Logical level (pullup off, 
input pins only)  

The logical level of the input pin. Appears if the pull-up is off. Values: 
Logic level [1.8 V | 3.3 V | 5 V TTL | 5 V CMOS | 9 V | 12 V].  



 
 

12 TRBOnet Swift CPS 1.8 – User Guide 
 

Setting Description 

Default level (output pins 
only) 

The level set on the output pin by default after restart of the device.  
Values: Default level Low, Default level High, Save last state. 

Debounce The debounce of the input signal. Values: Debounce [off | 100 | 200 
| 300 | 500 | 700 | 900] ms. 

 

Note: To learn the details about configuring the I/O pins of Swift A200, refer to the 
TRBOnet Swift A200 User Manual. You can download the TRBOnet Swift 
A200 documentation from www.trbonet.com. 

 NRF Settings 
A configuration includes the NRF Settings section when you configure Swift A200 
(NRF RoIP Gateway) or Swift ST002. 
Configure the wireless (NRF) connection between a device and the option board 
installed in the connected radio. Both parties have the Nordic RF transceiver onboard. 

Setting Description 

Data transfer rate The data transfer rate for wireless communication. Values: 1 Mbps, 2 Mbps. 
Default: 2 Mbps. 

Channel The channel for wireless communication with the radio. Range: 0 to 125. 

Power The power of the device. Values: 20, 60, 250, 1000 µW. 

Default: 1000 µW. 

Address The group call ID on the NRF radio network. For wireless communication on 
an NRF network, the modules need to be programmed with the same 
address. Default: E7:E7:E7:E7:E7. 

Width address The number of sections (left to right) in the NRF address (above) to be 
considered. Values: 3, 4, 5. Default: 3. 

 Network Settings 
A configuration includes the Network Settings section when you configure Swift 
A200. To configure the IP connection between the device and the TRBOnet network, 
specify the following settings. 

Setting Description 

IP Address The IP address assigned to the device. 

Subnet Mask The mask of the subnet to which the device belongs. 

Default Gateway The default gateway of the IP network. 

MAC Address The network address of the device. 

 

4.4.3 Swift Event Logic 
This section describes how to configure the Swift Event Logic settings on a device. 

http://www.trbonet.com/
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 Operations with Logic 
You can import and export the Logic section of a configuration using commands on 
the Logic Information page. 

 

Use these commands only when requested by the support team of the product 
vendor. In all other cases, manage the device configuration as described in section 
4.4.1, Configuration Files (page 8). 

To save logic to XML file: 
• On the Logic Information page, click Save as xml in the right panel. 
• Go to the destination folder and save the file with the preferred name. 

To import logic from XML or SWR file: 
• On the Logic Information page, click Clear in the right panel. The Logic 

section now displays Logic information only. 
• Click Import logic. 
• In the system dialog box, select the type of file with the external logic – XML or 

SWR. Select the file and click Open. 
The logic imported from SWR is displayed in the Logic section. The logic 
imported from XML is not displayed, the Logic section only includes Logic 
information. 
The Logic information section shows the name of the source file. 

 Report Settings 
If configured accordingly, a device can collect incoming information in the memory, 
create data sequences (reports), and send them to TRBOnet Server over a radio 
channel or via a Wi-Fi connection. Reports typically include the current location of a 
connected radio and telemetry from the input pins. 
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To define rules for creating and sending reports, create a profile with report settings. 
You can create as many profiles as necessary. One profile must be indicated as default. 
The default profile is loaded to the device memory at startup. 
To configure report settings in an opened configuration, click Reports in the Logic 
section of the navigation panel. 

 

The Report profiles tab displays all profiles with report settings that are defined in 
the opened configuration. 

• Send battery status 
Select this option so that the radio will include battery status each time it 
sends a data packet to TRBOnet Server. 

• Include telemetry data in each report 
Select this option so that the radio will include telemetry data in each report. 

In the default configuration, there are two predefined report profiles: Radio Report 
Profile and Wi-Fi Report Profile. 
You can manage report profiles as described below. 

To create a profile: 

• Click Add. 
• In the Edit Report Profile window, specify the report settings as described in 

section 4.4.3.2.1, Editing Report Profile (page 15). 
• Click OK. 

To set a default profile: 
• Select the profile and click Set Default, 

or 
select the Default box next to the profile name. 
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To edit a profile: 
• Select the profile in the list and click Edit, 

or double-click the profile. 
• Edit the report settings as described in section 4.4.3.2.1, Editing Report Profile 

(page 15). 
• Click OK. 

To delete a profile: 
• Click the Delete icon next to the profile name. 

The profile is deleted and cannot be restored. If you delete the default profile, 
the last profile in the list becomes the default one. 

Note: You cannot delete the last remaining profile. 

4.4.3.2.1 Editing Report Profile 
Specify the report settings in the Edit Report Profile window. Click OK to save the 
profile. 

 

• Profile name 
Click this field to enter/edit the name of the report profile. 

GNSS Report Creation 
• Add GNSS data every (m) 

The GNSS data will be added to the report each time the specified distance (in 
meters) is traveled. 

• Add data at minimum direction change 
The minimum direction change, in degrees, at which GNSS data is added to 
the report. 

• Add GNSS data every (sec) 
The GNSS data will be added to the report each time the specified time 
interval (in seconds) elapses. 
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Report Sending 
• Sending a report 

From the drop-down list, select one of the following options: 
 Do not send 

Creating and sending GNSS reports is disabled. 
 On the selected channel 

The radio sends reports on the currently selected channel. 
 On the data channel 

The radio sends reports on the data channel. 
• Send report every (m) 

The radio will send a report each time the specified distance (in meters) is 
traveled. 

• Send report every (sec) 
The radio will send a report each time the specified time interval (in seconds) 
elapses. 
Note that in Wi-Fi Report Profile, this value must not exceed 6 sec. 

• Number of retries 
The number of retries for sending a report on the radio channel. 

• Retry interval 
The time interval, in seconds, between retries. 

Advanced 
• Synchronize time with TRBOnet Server 

Select this checkbox so that time on the radio will be synchronized with 
TRBOnet Server. 

 Network settings 
You can also specify settings for the network media over which reports are sent to 
TRBOnet Server. 
To configure network settings, click Networks in the Logic section of the navigation 
panel. 
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The Network profiles tab displays all profiles with network settings that are defined 
in the opened configuration. 
In the default configuration, there are two predefined network profiles: Radio 
Network Profile and Wi-Fi Network Profile. 
You can manage the network profiles as described below. 

To create a profile: 
• Click Add. On the drop-down menu, click either Radio network profile or W 

network profile. 
• Specify the network settings in the appropriate Network profile window as 

described in sections 4.4.3.3.1 or 4.4.3.3.2. 
• Click OK. 

To set a default profile: 
• Select the profile and click Set Default, 

or 
select the Default box next to the profile name. 

To edit a profile: 
• Select the profile in the list and click Edit, 

or double-click the profile. 
• Edit the network settings as described in sections 4.4.3.3.1 or 4.4.3.3.2. 
• Click OK. 

To delete a profile: 
• Click the Delete icon next to the profile name. 

The profile is deleted and cannot be restored. If you delete the default profile, 
the last profile in the list becomes the default one. 

Note: You cannot delete the last remaining profile. 
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4.4.3.3.1 Editing Radio Network Profile 
Specify the network settings in the Radio Network Profile window. Click OK to save 
the profile. 

 

• Profile name 
Click this field to enter/edit the name of the radio network profile. 

• MOTOTRBO network CAI +1 
The MOTOTRBO network identity (CAI) increased by 1. This increment is 
required to send data to TRBOnet Server. Example: If MOTOTRBO CPS defines 
the network CAI 12, enter 13. 

• TRBOnet Server ID/Radio ID 
The unique radio ID of TRBOnet Server in the MOTOTRBO network. 

• TRBOnet Server port 
The port of the PC where TRBOnet Server is running (4104, by default). 

4.4.3.3.2 Editing Wi-Fi Network Profile 
Specify the network settings in the Wi-Fi Network Profile window. Click OK to save 
the profile. 

 

• Profile name 
Click this field to enter/edit the name of the Wi-Fi network profile. 

• TRBOnet Server IP 
The IP address of the PC where TRBOnet Server is running. 

• TRBOnet Server port 
The port of the PC where TRBOnet Server is running (4180, by default). 
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 Rules 
A rule describes a specific event to which a programmed device will respond with a 
predefined sequence of actions, such as playing back tone or displaying text on the 
radio display, sending text to other radios, changing the radio channel, sending 
alarms, and other. 

 

To configure rules, expand the Logic section and click Rules in the left panel. 
The Rules page displays a predefined set of rules. You can manage rules as described 
below. 

To create a rule: 
• Click Add and on the drop-down menu click the event type. 
• In the Create Rule window, define the rule as described in section 4.4.3.4.1, 

Creating/Editing a Rule (page 20). 

To create a copy of an existing rule: 
• Select the rule in the list and click Copy. 

A copy of the selected rule is added to the list. 
• Edit the rule name and settings as described below. 

To edit a rule: 
• Double-click the rule or select it in the list and click Edit. 
• Modify the rule settings in the Edit Rule window as described in section 

4.4.3.4.1, Creating/Editing a Rule (page 20). 

Delete a rule 
• Select the rule in the list and click Delete. 
• Confirm the deletion in the prompt dialog box. 

Enable all rules that you want to write to the device memory and be executed at 
runtime. 
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To enable a rule: 
• Select the rule in the list and click Enable, 

or select the Enabled box next to the rule name. 
4.4.3.4.1 Creating/Editing a Rule 

The Create/Edit Rule window serves for creating and/or editing the Event Logic rule. 

 

To define a rule: 

 Specify the name of the rule in the Name field. 
 In the Event panel, specify the properties of the event. For a brief description 

of the event, click the "i" icon at the window's top right. 
 In the Conditions panel, add as many conditions as required. Configure 

conditions as described in section 4.4.3.4.3, Conditions (page 22). 
 In the Actions panel, select actions to execute when the event occurs. 

Configure each action as described in section 4.4.3.4.4, Actions (page 23). 
 Click OK to save the rule. 

4.4.3.4.2 Events 
The following table summarizes the information about all supported events and their 
configurable properties. 

Event Description 

Start of Device This event is triggered when the radio starts up. 

Geofencing This event is triggered when the radio enters/exits the designated region for 
a time longer than the wait timeout. 

Properties: 

 Region: Select the region the borders of which are monitored. 
 Direction: Select if the region is entered or left. 

Swift Command This event is triggered when the Swift command is received from TRBOnet 
Server. Properties: optional parameters 1, 2. 
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Event Description 

Telemetry This event is triggered when the status of any I/O pin has changed on the 
device. 
Properties: 

 Input: Select the Input pin #. 
 Input trigger: Select the type of change occurring to the pin (turned on, 

off or toggled) 

Incoming Call This event is triggered when the incoming radio call has started/ended. 

 Call trigger: Select whether the call is started or ended. 
 Call from: Select whether the calling party is the radio or radio group. 
 Group ID: Enter the radio ID of the radio or radio group. 
 Enable debug mode: Select this option to show debug information on 

the radio display. 

Radio Channel This event is triggered when a different channel and/or zone is selected on 
the radio. 

 Zone: Enter the zone number. 
 Channel: Enter the channel number. 

Radio Button This event is triggered when the designated radio button is pressed/released. 

 Button: Select the radio button. 
 Action: Select the type of action. This can be Short press, Long press, or 

Release. 

iBeacon This event is triggered when an iBeacon is discovered/lost. 

 iBeacon trigger: Select whether the iBeacon is discovered or lost. 
 Major ID: Enter the beacon’s major ID exactly as specified in the iBeacon 

device. 
 Minor ID: Enter the beacon’s minor ID exactly as specified in the iBeacon 

device. 

Presence 
Detection 

This event is triggered when the beacon specified in the Presence Detection 
page is discovered/lost. 

 iBeacon trigger: Select whether the iBeacon is discovered or lost. 

Wi-Fi Network This event is triggered when a Wi-Fi network is connected/disconnected. 

 Network trigger: Select whether the Wi-Fi network is connected or 
disconnected. 

 Wait timeout: Enter the minimum duration of staying 
connected/disconnected. 

Rollover Detection This event is triggered when the mobile radio tilt is below the threshold angle 
for a time longer than the pre-alarm duration. 

 Threshold angle: The minimum vertical angle (in degrees) at which the 
radio is still considered up. 

 Pre-alarm duration: The timeout (seconds) after detecting the radio tilt. 

Note: After installing the radio in the working position in a car, you need to 
set a custom axis orientation of the accelerometer. This is done by 
clicking Set a custom axis orientation of the accelerometer in the 
Service page. 
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Event Description 

Crash Detection This event is triggered when the radio acceleration exceeds the impact 
threshold, the speed drops to zero within the idle timeout, and then there is 
no movement for the duration of the wait timeout. 

 Impact acceleration threshold: The maximum acceleration that shall be 
exceeded to suspect a car crash. 

 Wait timeout: The timeout, in seconds, that starts after the suspected 
car crash and during which no acceleration measurements are taken. 

 Acceleration threshold: The minimum acceleration that must be gained 
during the control time to confirm the normal speed mode. 

 Idle timeout: The timeout, in seconds, that starts after the wait timeout. 

Lone Worker This event is triggered when there is no user activity for a time longer than 
the response time. The timer will rest after pressing any radio button or knob. 

 Response time: The timer, in seconds, that restarts after a button push, a 
talk, or use of the channel selector was detected on the radio. 

No Movement This event is triggered when the radio acceleration is below the threshold for 
a time longer than the wait time. 

 Acceleration threshold: The minimum acceleration at which the radio is 
still considered to be at normal speed. 

 Wait time: The timeout, in seconds, that starts after the radio 
acceleration has fallen below the threshold. 

Speed Limit This event is triggered when the measured speed exceeds or falls below the 
threshold. 

 Speed: The math operator. Values: greater than, less than. 
 Threshold value: The maximum or minimum allowed speed in 

kilometers per hour. 

Note: The speed measurement error may be as high as 5 to 10%, depending 
on the type of a two-way radio (less for mobile, higher for portable) 
and on the satellite signal reception quality. 

 
4.4.3.4.3 Conditions 

In the Conditions panel of the Create/Edit Rule window, add one or more conditions 
for the event to be handled. 

Note: Adding conditions to a rule is optional. If you add multiple 
conditions, at least one of them must be TRUE for the actions in 
the Actions list to be triggered. 

To add a condition: 
• In the Conditions panel, click Add and select one of the following condition 

types. 
 Region 

In the Geofencing Condition dialog box specify the following parameters: 
• Position 

From the drop-down list, select 'Inside' or 'Outside' position in a region. 
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• Region 
From the drop-down list, select the desired region. 

 iBeacon Presence 
In the iBeacon Presence Condition dialog box specify the iBeacon's 
Major ID and Minor ID. 

 Flag 
In the Flag Condition dialog box specify the flag (a number from 1 to 32) 
that is checked to be set to On. 

 Pin State 
In the Pin State Condition dialog box specify the Status (On/Off) and 
select the Input(s) which status to be checked. 

Once added, the new condition will appear at the last position in the Conditions 
panel. The order of conditions in the list cannot be changed and does not affect the 
logic. To open condition settings for editing, double-click the required condition in 
the panel. To delete a condition, select it and click the Delete button. 

4.4.3.4.4 Actions 
In the Actions panel of the Create/Edit Rule window, add one or more actions to 
execute when the event has occurred and all conditions have been confirmed. 

To add an action: 

 In the Actions panel, click Add Action and on the drop-down menu click the 
action type. 

 In the dialog box that opens, specify action properties and click OK. 

 

A new action with the specified name appears at the last position in the Actions panel. 
Use Up and Down arrow buttons to adjust the execution order of actions. 
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To delete an action, click the Delete button. Double-click the required action to open 
its properties for editing. 
The following table summarizes information about actions and their properties. 

Action Description 

Play Tone This action forces the radio to play back the specified tone. Properties: 

 Tone: The tone to be played back. 
 Tone Type: Choose whether to play the tone momentarily or 

repetitively. 
 Volume shift: The volume boost (in MOTOROLA’s units of 

measure). 

Play Announcement This action forces the radio to play back a pre-recorded voice 
announcement. 

 Voice Announcement: Select one of the pre-recorded voice 
announcements. 

Display Text This action forces the radio to display text. 

Properties: 

 Text: Enter the text to display on the radio. 
 Position: The display line from which the text starts. Options: Line 

1, Line 2, Line 3, Line 4. 
 Alignment: Select the alignment of the text. 
 Font: Select the font style (Normal or Bold). 

Send Text This action forces the radio to send text to a specified radio or radio 
group. Properties: 

 Destination: The recipient of the message. Values: radio, radio 
group. 

 Radio ID: The radio ID of the recipient. 
 Text: The message to be sent. 

Send Alarm This action forces the radio to send a particular alarm to TRBOnet 
Server. 

Properties: 

 Alarm type: The type of alarm to be sent. Options: Crash Detection, 
Lone Worker, Man Down, No Movement. 

Emergency This action activates/deactivates the alarm mode on the radio. 

Set Radio Channel This action forces the radio to select a different radio channel/zone. 
Properties: 

 Channel: The radio channel to be set. 
 Zone: The zone to be set. 

Note: These are numerical values that are represented in MOTOTRBO 
CPS, Channels>Zone>Channel (in the Position column). 

Send Report This action will send a report to TRBOnet Server. 

 Priority: The values are: 'Immediately send to TRBOnet' and 
'Immediately send to TRBOnet with interrupt'. The latter option 
means that a report will be sent immediately, interrupting the 
current transmission, if the radio channel is busy. 
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Action Description 

Select Report Profile This action forces a device to use the specified profile with report 
settings. 

Note: A profile with report settings defines rules for sending reports to 
TRBOnet Server. See also section 4.4.3.2, Report Settings (page 
13). 

 Profile: Select the report profile to switch to. 

Select Network Profile This action forces a device to use the specified profile with network 
settings. 

Note: For information on network profiles, see section 4.4.3.3, Network 
settings (page 16) 

 Profile: Select the network profile to switch to. 

Send Command This action will send a Swift command to TRBOnet Server. 

 Command: Select the Swift command to be sent. 
 Priority: The values are: 'Immediately send to TRBOnet' and 

'Immediately send to TRBOnet with interrupt'. The latter option 
means that the selected command will be sent immediately, 
interrupting the current transmission, if the radio channel is busy. 

Set Telemetry Output This action will set the selected telemetry output to the specified state. 

 Action: Select the action for the output (Toggle, On, O). 
 Output: Select the radio's output to perform the specified action 

on. 

Set Flag This action will set the selected flag to the specified state. 

 Action: Select the action for the flag (Toggle, On, Off). 
 Flag: Specify the flag (a number from 1 to 32). 

Set Power Level This action will set the radio’s transmission power level for the current 
channel. 

 Power: The values are 'Low' and 'High'. 

Set Display Brightness This action will set the radio display brightness to a specified level. 

 Brightness: The values are 'Increase' (one step), 'Decrease' (one 
step), 'Maximum', 'Minimum' and 'Default' 

Lock Radio This action will lock/unlock the radio. 

Add STEP This will add an additional step to the Actions page. Double-click the 
step that appears and enter the duration, in seconds. 

 Regions 
The Event Logic rules use geographical regions as input parameters. A region is an 
area selected on the online map and given a unique name. Allowed are polygonal 
regions and circular regions with the maximum radius of 65.00 kilometers. 
To define regions, click Regions in the Logic section of the navigation panel. 
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In the right pane, select the Enable regions option. 
In the Presence timeout box, specify the minimum duration of stay within (if entered) 
or out (if left) of the region. This value will be used for Geofencing events. 
Regions appear on the map as colored areas. The region names are displayed in the 
right panel. 
The following useful features will help you work with the map: 

To pan the map: 
• Keep the left mouse button pressed and move the mouse cursor to the 

required direction. 

To adjust the scale level: 
• Scroll the mouse wheel to zoom the map. 

To select a different map: 
• Click the Map Settings button in the right panel. 
• In the Map Configuration window, from the Tile source drop-down list, 

select the preferred map. 
• Click Apply. 

Note that in the offline mode, the map is loaded from cache. 

To select the cache folder: 
• Click the Map Settings button in the right panel. 
• In the Map Configuration window, click the Search button next to the Root 

cache directory field. Find the destination folder and confirm the choice. Or, 
specify the folder path manually. 

• Click Apply. 
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You can perform the following operations with map regions. 

To add a polygonal region: 

• Click the Add Polygonal Region button ( ). 
• Click the map where the region border will start. Draw the shape of the region, 

clicking where you want to place nodes. The added nodes connected with lines 
make a region border. 

• Double-click to finish. The first and the last nodes will be connected with a line. 
The new polygonal region will appear in the right panel under the Regions 
List. 

To add a circular region: 

• Click the Add Circular Region button ( ). 
• Click the map where the center of the region will be located. 
• Release the mouse button and move the cursor away from the center.  The 

distance from the center (in km) is displayed near the region. The radius of a 
circular region is restricted to 65 km. 

• Double-click to finish. The new circular region will appear in the right panel 
under the Regions List. 

To edit a region: 
• Double-click inside the region on the map, or in the Regions List. 

The region on the map is highlighted and all of its nodes are displayed. 
• To drag a node to a different position, click it and keep the mouse button 

pressed. To drop the node, release the mouse button. 
• To delete a node, right-click it. 
• To move the entire region, point to its central point, click and drag it to the 

new position on the map. 
• To save changes, double-click on the map. Or, press Esc to cancel editing. 

 

To delete a region: 
• Select the region under the Regions List and click the Delete button. 

Note: The deleted region cannot be restored with the Undo command. 
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 iBeacon Tracking 
To configure iBeacon tracking, select the iBeacon Tracking section in the left panel. 

 

In the right pane, specify the following iBeacon-related settings: 
• Enable iBeacon tracking 

Select this checkbox to enable iBeacon tracking. 
• RSSI threshold 

Set the minimum signal strength, in negative decibels, of an iBeacon to 
consider it as discovered. 

• When an iBeacon is discovered 
From the drop-down list, select what to do when an iBeacon is discovered. 
 Add to report 

This will add information on a discovered iBeacon to the report. 
 Immediately send to TRBOnet 

This option means that the corresponding report will be sent immediately. 
 Immediately send to TRBOnet with interrupt 

This option means that the corresponding report will be sent immediately, 
interrupting the current transmission, if the radio channel is busy. 

• iBeacon loss timeout 
Enter the timeout, in seconds, within which an iBeacon is not considered as 
lost. 

• When an iBeacon is lost 
From the drop-down list, select what to do when an iBeacon is lost. 
 Add to report 

This will add information on a lost iBeacon to the report. 
 Immediately send to TRBOnet 

This option means that the corresponding report will be sent immediately. 
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 Immediately send to TRBOnet with interrupt 
This option means that the corresponding report will be sent immediately, 
interrupting the current transmission, if the radio channel is busy. 

• Enable debug mode 
Select this option to show debug information on the radio display. 

 Presence Detection 
To configure iBeacon presence detection, select the Presence Detection section in 
the left panel. 

 

In the right pane, specify the following iBeacon presence-related settings: 
• Enable iBeacon presence detection 

Select this option to enable iBeacon presence detection. 
• Major ID, Minor ID 

Enter the Major ID and Minor ID (the values or the ranges of values). 
• RSSI threshold 

Set the minimum signal strength, in negative decibels, of an iBeacon to be 
considered as discovered. 

• iBeacon loss timeout 
Enter the timeout, in seconds, within which an iBeacon is not considered as 
lost. 

• Enable debug mode 
Select this option to show debug information on the radio display. 

 GeoRoaming 
The GeoRoaming feature allows for automatic selection of the radio channel/zone 
depending on the geographical region and/or the proximity of certain iBeacons. 

• In the left panel, select the Presence Detection section. 
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In the right pane, specify the following GeoRoaming-related settings: 
• Location Priority 

From the list, select the priority to use for GeoRoaming. 
• Set default channel 

Select this option and specify the default channel and zone. This channel/zone 
will be automatically set on the radio when its location is not available or 
outside designated regions/iBeacons. 
 Channel 

Enter the default channel. 
 Zone 

Enter the default zone. 
• Lock selected channel 

Select this option so that the radio will prevent the user from changing the 
automatically selected channel. 

• Add 
Click this button and specify the following GeoRoaming parameters: 
 Zone 

Enter the zone to be set automatically when the radio stays in the selected 
region and/or in the vicinity of the specified iBeacon(s). 

 Channel 
Enter the channel to be set automatically when the radio stays in the 
selected region and/or in the vicinity of the specified iBeacon(s). 

 Region 
From the list, select the region within which the radio must stay so that the 
specified channel/zone will be set automatically. 

 iBeacon Major, iBeacon Minor 
Specify the Major ID and Minor ID of the beacon(s) in the vicinity of which 
the radio must stay so that the specified channel/zone will be set 
automatically. 
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5 Activation of Features 
To learn the statuses of all licensed features on a device, connect the device to your 
computer and read the configuration of the device in TRBOnet Swift CPS. In the left 
panel, click Device and License Information. 

 

In the right panel, all the licensed features that are supported by your device are 
marked as Activated, Available for activation, or Not available (not supported on 
your type of device). 

To activate features on a device: 

 Click Activate features. 
 In the Activate features window, enter the license key and click Check. 
 If the license key is valid, the Activate features window displays all features 

included into the license (Error! Reference source not found.). You can learn 
how many times each feature was activated on different devices using this 
license, and how many more activations are allowed. 

 Click the Activate features button. If this button is unavailable (grayed out), 
your device works in the demo mode. Click the Restore features button to 
return to the normal mode and activate all purchased features on the device. 

Note: When you choose the demo mode and then the normal mode on a device, 
the license counter is not incremented. 
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